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User Notes
1.
This Case Study is intended to serve as an aid to applicants interested in preparing an application for an EPA equivalent method determination for a candidate PM2.5 or PM10-2.5 Class II or Class III ambient air monitoring method.  (Class II methods are filter-based, integrated-sample type manual methods; Class III methods are defined as automated, continuous, near-real time PM analyzers.)  Such an application would be submitted to the EPA under the regulatory provisions of Title 40, Part 53 of the Code of Federal Regulations (40 CFR Part 53).  The EPA considers the merits and performance capabilities of a candidate method based on the information and specific test results contained in the submitted application.  If the candidate method is found to satisfy all the applicable equivalent method requirements, the method is designated by the EPA as a Federal equivalent method (FEM) under Part 53.  EPA-designation of a method as an FEM allows the method to be used by State, Local, and Tribal air monitoring agencies in their ambient air monitoring networks to determine attainment of EPA’s national ambient air quality standards (NAAQS) for particulate matter.  FEM designation also affords a monitoring method enhanced credibility in regard to its reliability and fidelity in providing air quality measurements similar in quality to measurements obtained by the Federal reference method (FRM) for the corresponding PM indicator (PM2.5 or PM10-2.5).
2.
This Case Study includes example paragraphs typical of the types of specific information, or of the nature of the information, that is required to be included in an EPA FEM application.  These, or similar, paragraphs should be revised, rewritten, or augmented and tailored as appropriate to be specific for the particular subject candidate method.  In particular, the [bold, green text enclosed in brackets] is merely hypothetical example text and should be replaced with similar, appropriate text specifically related to the subject candidate method, or to its associated testing protocol and test results, for which the application is being prepared.
3.
The resource file, Part 53 Reg amendments.dot, provides the formal FEM and application requirements in the actual Part 53 regulation language for convenient reference.  The Case Study incorporates convenient hyperlinks to context-specific provisions of this regulation to confirm a particular requirement and to reference the details of the more complex requirements.  Note that this Part 53 resource file contains only the new provisions and amendments to 40 CFR Part 53 that became effective on December 18, 2006 (unless otherwise indicated).  Generally, these new and amended provisions are the ones that are of principle concern in the preparation of applications for FEM designation of Class II and Class III candidate methods for PM2.5 or PM10-2.5.  However, the unrevised sections 53.6, 53.7, and 53.10 through 53.16 are also applicable and may be of interest, as well.  The previously existing version of Part 53 (containing the non-amended sections) is available at http://www.access.gpo.gov/nara/cfr/cfr-table-search.html#page1.  The complete content of Part 53, including the 12/18/06 amendments, should be available at this web site after July 1, 2007. 
4.
For the links to the Part 53 regulation language to work, the Part 53 Reg amendments.dot resource file must reside in the same folder as this Case Study file.  This resource file (template file) will open automatically in Word as a second document along with this Case Study file (the first link that opens the document may not go to the correct place in the document).  Note: the resource file contains a small macro, and if you get a macro warning message, you may safely enable the macro.  (To avoid the macro warning, you may set your Word macro security to “low” (Tools>Options>Security>Macro Security.)  For best use of this resource file, the “Document Map” should be visible on the left side.  If the document map is not there (because the macro was disabled), click on the View menu and then on Document Map to activate it.  The Part 53 resource file has an outline structure, so that the Document Map may be used to go to specific sections, tables, figures, or equations of Part 53 (figures appear only when in the Print Layout view).  It is also presented such that both an Internet-type tool bar and the outline tool bar should be present and available for use.
5.
In the Case Study, section numbers in brackets ( [§53.35…] ) are hyperlinks directly to that section of the Part 53 regulation language on the resource file (Part 53 Reg amendments.dot) and usually include tips with additional information. Other underlined blue text also offers tips and links to pertinent regulatory requirements or other potentially useful information.  After viewing a linked reference to the Part 53 regulation, the Internet-style “back” button 
[image: image1] may be used to conveniently return to this Case Study document.  Some links take you to other parts of this Case Study document; and if you don’t have a “back” button 
[image: image2] to take you back to your previous place in this document, you can get one by clicking on View>Toolbars and then on “Web.”
6.
If this Case Study is used as a framework for the preparation of an actual EPA FEM application, it is suggested that one copy of the Case Study file be kept intact to serve as a reference and model, and a second copy might be revised and rewritten as necessary to tailor it to the subject candidate method and applicant.  As this is carried out, the bracketed section references and underlined hyperlinks should, of course, be deleted.
7.
The Case Study is structured to provide a basic skeleton to address the various different types of information required in an application.  No particular format or structure for this information is mandated by Part 53, as long as all the required information is contained in the application and submitted. Although the body of this Case Study document with the example information paragraphs is rather modest in length, a substantial amount of other, highly detailed information is required in the application.  This includes information regarding such aspects as the nature and design of the candidate method, the manufacturing quality system applicable to the candidate method, its operating or instruction manual, the manufacturing facility ISO registration documentation, location information for the test sites, details of the installation, calibration, and operation of the test instruments or samplers at each test site, the test data obtained at each test site, and (in the case of Class III candidate methods) hourly data obtained during the field tests.  The use of attachments to a base application framework, as suggested by this Case Study, is only one of perhaps other ways that this very detailed supplemental information may be included in the application.  While most information is typically expected to be in hard copy, certainly some types of information, e.g. test data, might be better attached and submitted on some form of computer-readable electronic media.
8.
Questions regarding the submission of an FEM application or clarification of the FEM testing or other Part 53 regulatory requirements should be directed to the Reference and Equivalent Method Program, MD D205-03, U. S. Environmental Protection Agency, Research Triangle Park, NC  27711  (Phone: 919-541-3737, e-mail: Hunike.Elizabeth@epa.gov).  See also the Notice to Potential Applicants and the PM FEM FAQs documents, as well as other information or guidance documents that may be posted from time to time, at www.epa.gov/ttn/amtic (>Criteria Pollutants).

Application for a [PM2.5 or PM10-2.5] Equivalent Method Determination Under 40 CFR Part 53
1.  General Information
1.1  This application is submitted to the Director, National Exposure Research Laboratory, Reference and Equivalent Method Program (MD-D205-03), U. S. Environmental Protection Agency, Research Triangle Park, North Carolina 27711 for an equivalent method determination under 40 CFR Part 53 on a candidate method based on the [Fine Instrument Company’s Model XYZ-123 PM2.5 Ambient Air Monitor]. [§53.4(a)]
1.2  This application is submitted by [Mr. M. T. Fine] under his signature as an authorized representative of:  [§53.4(b)]
[Fine Instrument Company, Inc.

Air Monitoring Instrument Division

12345 67th Street

Paradise, Montana, 99999]
[M. T. Fine]
[M. T. Fine, Director of Ambient Air Instruments]
1.3  This application, including all its contents and any additional information submitted subsequently that is intended to become an integral part of the application, is hereby identified as confidential or privileged information in accordance with 40 CFR §53.15.
1.4  The candidate method for which this application is submitted is identified as the [Fine Instrument Company’s Model XYZ-123 PM2.5 Ambient Air Monitor].  [§53.4(b)(1)]  This method is described in the associated [Model XYZ-123 Operation and Instruction Manual (configured for PM2.5) (Attachment 8)] and [Attachment 1], both of which are included as parts of this application. [§53.4(b)(2)]
1.5  The required, comprehensive [Model XYZ-123 Operation and Instruction Manual] is included [as Attachment 8] and describes complete and detailed operational, maintenance, and calibration procedures for using the [Model XYZ-123 instrument]. [§53.4(b)(3)]
1.6  The candidate method described in this application has been tested in accordance with the procedures described in the applicable portions of Subparts C, [D, E and F].  [§53.4(b)(4)]    

1.7  Descriptions of the test facilities, test configurations, the test data obtained, test records, calculations, and test results are provided in [Attachment 5] in association with the discussion of each specific required test.  [§53.4(b)(5)]
1.8  The [Model XYZ-123 PM2.5 Ambient Air Monitors] tested in accordance with Part 53 are representative of the [Model XYZ-123 PM2.5 Ambient Air Monitor] described in this application.  [§53.4(b)(6)]

1.9  A detailed description of the quality system that will be used to ensure that all instruments offered for sale under an equivalent method designation for this candidate method will have essentially the same performance characteristics as the instruments tested for this application is contained in [Attachment 2].  [Attachment 2] also describes the durability characteristics of the instrument and its warranty program that ensures that the instrument will meet the required specifications throughout the warranty period.  [§53.4(c)]

1.10  Upon request of the EPA Reference and Equivalent Method Program, an instrument that is representative of this candidate method will be shipped to EPA for test purposes in connection with this equivalent method application.  [§53.4(d)]

2. Description of the Candidate Method

2.1  [The Model XYZ-123 PM Monitor is an automatic beta attenuation type PM analyzer that can be configured with various inlets and particle size separators.  For this equivalent method application, the candidate analyzer is configured with a PM2.5 particle size separator to provide near-real time measurements of ambient concentrations of PM2.5.  This configuration is identified as the Model XYZ-123 PM2.5 Monitor and described completely in the Model XYZ-123 Operation and Instruction Manual (configured for PM2.5), with supplemental information provided in Attachment 1, both of which are included as integral parts of this application.  In consideration of the nature of the Model XYZ-123 PM2.5 Monitor, we believe this candidate method should be categorized as a Class III candidate equivalent method for PM2.5.]  [§53.1(II) – Class II]  [§53.1(III) – Class III]
3. Requirements for the Design, Configuration, Operation, and Manufacturing of the Candidate Method


3.1  [The Model XYZ-123 PM2.5 Monitor meets all “reasonably applicable” requirements of 40 CFR Part 50, Appendix L and Part 53, Subpart E as described in this section 3.]  [§53.3(a)(3) – PM2.5 Class II methods]   [§53.3(a)(5) – PM10-2.5 Class II methods]   [§53.3(b)(3) – PM2.5 or PM10-2.5 Class III methods] 

3.2.  [The Model XYZ-123 PM2.5 Monitor] is manufactured in an ISO 9001-registered facility.  See [Attachment 3] for the ISO 9001 registration documentation.  [§53.3(a)(6) or (b)(4)]
4.  Description of the Field FRM Comparison Tests (Part 53, Subpart C) [§53.3(a) (for manual methods) or §53.3 (b) (for automated methods)]

4. 1  [The Model XYZ-123 PM2.5 Monitor] was tested for comparability to the [PM2.5 or PM10-2.5] reference method at each of [two or four] test sites, as required by Table C-4 of Subpart C.  [§53.35(a) – Overview]  [§53.35(b) – Required test sites]  The test site locations are identified and described in [Attachment 4] along with pertinent information, data, and a narrative summary to show that each site has characteristics that meet the specific site requirements of Table C-5 of Subpart C.  [§53.30(b) – General site requirements]  [§53.35(b)(1) – Specific site requirements]  [Note that these test site locations and the associated supporting information have been submitted to EPA previously under §53.30(b)(2), and the test sites have been tentatively approved by EPA, as evidenced by the EPA Letter of Approval dated [date of Letter] and included in Attachment 4].

4.2  The comparability tests at each site were conducted in the required seasons, as required by Table C-5 and defined in §53.35(b)(2), as follows:  [Site A, winter and summer; Site B, winter; Site C, winter; Site D, summer.]  The actual dates of the test days for each site are given in the test data Excel spreadsheets submitted under Section 5, below.

4.3  All test concentrations obtained at all required test sites were within the 3 to 200 μg/m3 concentration range required by Table C-4, as shown in the test data Excel spreadsheets submitted under Section 5, below [except for 3 test days at test site D, on which the mean concentration measurements of the FRM samplers were less than 3 μg/m3].  [§53.35(b)(3)]


4.4  At each test site, three collocated reference method (FRM) single-filter samplers and three collocated [Model XYZ-123 PM2.5 Monitors] (candidate method) were installed and operated concurrently to obtain simultaneous test measurements of PM2.5 concentrations at the site. The ambient air inlet points of all samplers and monitors were positioned at approximately the same height above ground level and were separated horizontally between 1 and 4 meters, as required, [except at site C, where physical limitations of the available space at the test site required two of the test instruments to be horizontally separated by about 5 meters].  Diagrams, photos, and other information describing the details of the setup of the samplers and monitors at each test site are included in [Attachment 4].   [§53.35(c)(1)]  

4.5  All FRM samplers were installed, calibrated, and subsequently operated in accordance with 40 CFR Part 50, Appendix L, with their manufacturer’s operation and instruction manual, and with applicable portions of “Quality Assurance Document 2.12.”    The [Model XYZ-123 PM2.5 Monitors] were setup, calibrated, and operated in accordance with the [Model XYZ-123 Operation and Instruction Manual (configured for PM2.5)], a copy of which is included in this application as [Attachment 8].  [§53.30(e) and (f)]  [§53.35(c)(1)]

4.6  Information regarding the calibration of the FRM samplers and the [Model XYZ-123 PM2.5 Monitors], the calibration data, and the calibration standards used in calibrating the test instruments is contained in [Attachment 5].  [§53.30(g)]
5.  Field Comparison Test Data and Test Calculations

5.1  All comparison test data obtained from the comparability tests have been entered into site-specific copies of the EPA-provided Excel spreadsheet (PM Comparability Test data template.xls), one spreadsheet set for each test site.  [www.epa.gov/ttn/amtic (>Criteria Pollutants)]

5.2  As is shown by the test data spreadsheets, not less than 23 valid daily sets of comparison data were obtained at test sites [B, C, and D], [and not less than 46 valid daily sets of comparison data were obtained at test site A, even though a few of the data sets were not valid at some sites for various reasons noted in the Comments column of the spreadsheets].  [§53.35(c)(2)]  All valid data sets obtained during each test campaign are included in the respective test data spreadsheets.  [§53.35(c)(3)]

5.3  All daily integrated PM concentration test measurements were of at least [23 hours duration, typically running from 11:00 am to 10:00 am the following day and identified by the date when the sample was started].  The sample filters were retrieved each day, stored and transported to the weigh laboratory every 3 days in an ice cooler, and kept in refrigerated storage at the weigh laboratory.  All FRM sampler filters were weighed by [weigh laboratory] at least [weekly].  Filter handling and other aspects of the FRM test measurements were in compliance with the FRM reference method and in general accordance with “Quality Assurance Document 2.12.”  [§53.35(c)(4)]

5.4  Measurements corresponding to the FRM measurements were obtained by the [Model XYZ-123 PM2.5 Monitors] in accordance with the [Model XYZ-123 Operation and Instruction Manual (configured for PM2.5) (Attachment 8)].  [Twenty-three hour averages corresponding to the collection time of the FRM samples (i. e., 23-hour averages over the same 11:00 to 10:00 am time period as the corresponding FRM samples) were calculated for each daily data set from the one-hour averages provided by the Model XYZ-123 PM2.5 Monitors.  These calculated averages were entered into the spreadsheets.]  The original hourly measurement data are contained [on a CD as Attachment 7].  [§53.35(c)(5)]

5.5  As noted above, all comparison test data obtained from the comparability tests have been entered into the EPA-provided Excel spreadsheets, using a separate spreadsheet set for each site.  [Data from both winter and summer test campaigns at site A have been combined and entered into the Site A spreadsheet set.]  [Other than calculating the 23-hour average concentration measurements from the 1-hour measurements provided by the Model XYZ-123 PM2.5 Monitors corresponding to the time periods of the FRM integrated samples,] all measurements are reported as obtained from the respective samplers or test monitors.  [§53.35(c)(6)]

5.6  All calculations of the test data are carried out by the EPA spreadsheets [Attachment 6] and are therefore presumed to be correct.  The summary tab in each of the spreadsheets indicates that the [Model XYZ-123 PM2.5 Monitor] passed all required tests, [although the slope of the comparison for Site C was marginal.  This resulted from a prolonged period of rainy weather that occurred during the test, which caused relatively low PM2.5 concentrations with relatively little day-to-day variation.  Although additional test data (in excess of the minimum 23 days) were obtained, the CCV for the test was still quite low and the slope was not well defined statistically because of the clustered nature of the test data.]  [§53.35(d) – (h)]
6. Attachments

[Attachment 1
Technical Aspects of the Model XYZ-123 PM2.5 Monitor]

[This attachment may include additional technical details to describe the design, configuration, construction, function, operation or other aspects of the candidate method to supplement the information contained in the manual or to include technical information that can’t be in the manual because of the confidential nature of the information.  [§53.4(b)(2)] ]
[Attachment 2
Manufacturing quality system and analyzer durability characteristics for the Model XYZ-123 PM2.5 Monitor]


[This attachment should include detailed information as required by  Section 53.4(c) of the Part 53 regulation.]
[Attachment 3
ISO-9001 registration documentation]

[This attachment should include detailed information as required by Section 53.3(a)(6) or (b)(4) of the Part 53 regulation.]
[Attachment 4
Test site locations and supporting information]

[This attachment should include details and documentation to support the selection of each test site location, including maps or other information to identify its location, photos or other information to describe the nature and character of each test site, and information to justify its acceptability as a test site that meets the specified requirements.  The latter may include a narrative justification supplemented with recent, nearby pollutant measurements, weather and climatic data characteristic of the site, emission inventory data or a description of predominant pollutant sources in the area, and the influence of particularly nearby sources or obstructions.    [§53.30(b) – General site requirements]  [§53.35(b)(1) – Specific site requirements]  [Table C-5]  Note that pre-approval of a test site or all test sites may be obtained from the EPA prior to conducting the tests to provide assurance that one or more test sites or site locations will not be disapproved after the test data is obtained and the application is submitted.  [§53.30(b)(2)]]
[Attachment 5 
Instrument calibrations, calibration data, calibration standards, and other test documentation]

[This attachment should contain the documentation of all pertinent details of the test setup at each site, including: diagrams or other information on the arrangement and installation of both the candidate method instruments and the FRM samplers, records of the calibration of each instrument or sampler, certifications of the calibration standards used, operational protocols for each test instrument and sampler for each test day, qualifications of the instrument operator(s), and full details and explanation of any malfunctions, service or repair requirements, unusual circumstances or occurrences, or any events that may have an effect on the test data obtained and what such effect might be. [§53.4(b)(5)] ]
[Attachment 6
Comparability test data] 

[This attachment should contain the actual test data obtained in the comparability tests at each site.  The data may be submitted on paper, but more typically would be submitted in a spreadsheet or other appropriate data format on a CD or other electronic medium.  It is suggested that the EPA-provided spreadsheet (PM Comparability Test data template.xls) be used to submit the test data, using a separate copy of the spreadsheet for each site, as this spreadsheet is pre-programmed with a suitable data format and also automatically carries out the required checks and test calculations using the test data. This special spreadsheet may be downloaded from the EPA website at www.epa.gov/ttn/amtic, (>Criteria Pollutants).   If the EPA spreadsheet is not used, the various calculations for each test should be carried out by other means and reported along with the test data.  All calculations should be shown in sufficient detail so that they can be verified.
[Attachment 7
Hourly data from the Model XYZ-123 PM2.5 Monitors]


[If the candidate method is a Class III (automated analyzer), submission of hourly averages measured by each test analyzer during the comparability tests is required.  These data may be submitted as hard copy but more typically would be submitted in one or more spreadsheets or other appropriate format on a CD or computer readable medium, as Attachment 7.  [§53.35(c)(5)] ]

[Attachment 8
Model XYZ-123 Operation and Instruction Manual (configured for PM2.5)]

[The Operation and Instruction Manual is a very important part of the candidate method.  Section 53.4(b)(3) of the Part 53 regulation describes the content requirements for this manual.]
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